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Notation Used in this Document

e Key sequences that you may type are enclosed in a box. For example,
indicates that you are should press the “Enter” key.

¢ Dialog buttons are enclosed in a box with a gray background. For example,
where this document says “Select [OK[’, you should click the OK button or
navigate to the OK button and press the key.

¢ Menu sequences are indicated by one or more items with a gray background
(and no box), and separated by an arrow character “=”. For example, to
open a file you navigate with the mouse or the keyboard to the File = Open
dialog.

e Sections that apply only to Time Series Mode are marked with the ® icon,
and those that apply only to Assembly Mode are marked with the & icon.
These modes are explained later.



Overview

TenGun is a high-performance, easy-to-use
tool for working with Point Cloud data, and

is available for Windows, Linux, and macOS.

It is primarily targeted for use with SPH
(Smoothed Particle Hydrodynamics), CFD
(Computational Fluid Dynamics), and similar
analysis applications.

TenGun has the following usage scenarios:

TenGun (%%, pronounced like "Ten
Goon"), literally means "Point Cloud" in
Japanese.

This is not to be confused with the
mythical Tengu (X4) creature, which
is what everyone insisted on hearing
when | suggested this name.

- The author -

e Post-Processing, which we call “Time Series Mode”. This mode is used
to graphically inspect the output of an analysis application.

e Pre-Processing, which we call “Assembly Mode”. This mode is used to
assemble the parts from a CAD application and to convert them to the

input format of the analysis application.

e Text Editing. The editor can work with files either related to your analysis
work as well as files some other, unrelated use.

These usage scenarios are discussed in the following chapters.
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Getting Started

To start, follow these steps:

Install the program by opening TenGunSetup.msi. This is a
straightforward Windows setup application.

Obtain and install a License (refer to License Installation).

Run TenGun, either from the Desktop shortcut, the Start Menu shortcut,
or from the command line.

If you are using simple data files that do not contain a field information
header, you must register the list of fields in your data. This can be done
in the Edit - Settings screen.

License Installation

TenGun is available with the following licensing options:

Free. Includes the basic Time Series Mode viewer functionality and
supports a limited number of particles. It may be used for non-
commercial use, and no support is provided.

Advanced Viewer. Time Series Mode viewer, no particle limit, may be
used for commercial use, and support is available.

Reporter. Same as above, and allows creation of Reports and Charts.
Professional. All features including Assembly Mode pre-processing
features.

The "Free" version does not require a license file.

Advanced Viewers features and above require a valid software license to
operate. To set up a license:

Start TenGun and go to the Help = About window.

Click the “Request License for MAC Address xx-xX-Xx-xX-xx-xx” link. This
will send an email to us to request a license.

You will receive a reply with an attached file named "TenGun.lic"." You
may manually copy this to "C:\ProgramData\TenGun", or you may do the
following:

o Drag & Drop TenGun.lic to any folder, for example your Desktop
folder.

o Start TenGun if it is not already running.

Drag the license file into the TenGun main window.

o TenGun will install the license file for you.

(@]

2 — TenGun User Guide



NOTE: You cannot directly Drag & Drop an email attachment to install it.
However, you may first move the attachment to the file system (e.g., to the
Desktop), and then drag it into TenGun.

Command Line Options
The only command line option is currently “-lang”. The default language is the

same as the System language. To override the default specify “-lang en” for
English, or “-lang ja” for Japanese.
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Input File Formats

TenGun supports the following types of input files for Time Series and
Assembly Modes.

Type Extension Description Use Case
Plain data .dat Simple data file with no information Time Series
about the structure. Mode from

analysis output.

BMP .bmp Windows BitMaP image file.

Ccsv .csv "Comma Separated Values". The first Time Series
line of the file is expected to contain the | Mode from
names of the fields, and must minimally | analysis output.
include fields X, Y, and Z. CSV files can
be imported by many applications
including spreadsheets.

DICOM .dcm Digital Imaging and Communications in
Medicine (Xrays, CT-Scans, MRI
scans).

IGES .igs, .iges | "Initial Graphics Exchange Assembly Mode
Specification". A standardized format from CAD
for exchanging CAD drawings. exchange.

JPEG Jjpg, .jpeg | Joint Photographic Experts Group
image file.

LS-DYNA LS-DYNA d3plot. There are a huge
number of variations for this format, so
this is currently an Experimental
Feature.

oBJ .0bj A geometry definition file format Assembly Mode
originally developed by Wavefront from CAD
Technologies that contains geometry exchange.
and texture information.

PLY .ply "Polygon File Format" or "Stanford Assembly Mode
Triangle Format". Simple format from CAD
originally designed to store 3D-Scanner | exchange.
data. Binary and ASCII formats.

PNG .png Portable Network Graphics image file.

STEP .Stp, .step | A widely used CAD exchange format Assembly Mode
standardized under ISO 10303. CAD exchange.
TenGun supports the ISO 10303-203
and 1SO 10303-214 variants, which are
used in mechanical and automotive
design, respectively. Some other
variants may work.

STL st A "Stereolithography" file. Contains Assembly Mode
simple 3D triangulated surfaces but not | from CAD
much other information. Binary and exchange.
ASCII formats.

VTK vtk A legacy "Visual ToolKit" file. Binary Data exchange

and ASCI| formats.

with other
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graphics
applications
based on "VTK".

VTP vtp A "Visual ToolKit" XML-based file. Data exchange
Binary and ASCII formats. with other
graphics
applications
based on "VTK".

Hints

If you are working with CAD data in TenGun, we strongly recommend that
you use STEP format if possible. Although STL files are common, itis not a
good format for CAD models. STL was designed to store 3D-Printer data,
and these files do not contain design attributes that we need to perform
advanced editing operations. Furthermore, STL handling can be slow
because even seemingly simple objects can be represented internally by
many thousands of triangles.

LS-DYNA “d3plot” files is just one of the files created by an LS-DYNA
analysis. For TenGun to read LS-DYNA data you must provide all of the LS-
DYNA output files to TenGun, in addition to “d3plot”.
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Output File Formats
CAD Files

TenGun can write IGES, STEP, STL, VTK, VTP, and X3D or X3DB file formats.
This is useful for two purposes:

e Save your Assembly as you build it. Menu: File > Save Assembly.
If you need modify your data later,
the saved assembly is your backup.

e Export your Assembly in a different format for use with another
application.

STEP and IGES files can contain multiple parts.
As for STL:

e STL files can only contain a single part. Therefore, if you try to save a
multi-part assembly in STL format, TenGun will create multiple files with
“1”, “-2”, etc. appended to the output file name that you specify.

e |If you export a STEP or IGES file as STL, the output will consist of a
multitude of triangles. You cannot import an STL file and expect to then
convert it back to the same STEP or IGES object because original
connectivity information is lost in the export process.

STL, VTK, and VTP files are by default written in binary format. Select the
Save as Text | on the “Save Assembly As” dialog to write the files as ASCII Text.

Finally, TenGun can export an assembly as an X3D (.x3d) or X3D Binary
(.x3db) file. X3D is the successor to VRML. At this time we cannot read X3D
files, so we do not claim that we can convert between this and other formats.

Analysis Application Data Files
TenGun can convert your assembly to a data file suitable as input to an analysis

application. Requirements for this are specific to that analysis application and
are documented separately.
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Point Data Export

O Time Series point data can be saved in a text
file using File = Export = Selected Point Data.
This function saves the currently displayed (i.e.,
filtered) data, allowing you to export a subset of
a Time Series for use in another application.
The default settings will create a CSV file that
can be immediately loaded into a spreadsheet.

GGHTS\Tutorisls_public\chute wear\postichute_10800_PointCloud | []

You may save the data as a CSV (default), DAT, OBJ, PLY, STL, VTK, or VTP
file. By default, the output is written as ASCII text. You can also save PLY, STL,
VTK, and VTP files in binary format by unchecking the Save as Text option.
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Screen Layout & Navigation Tricks

Below is a screenshot of TenGun in action.

TenGun User Interface Layout

8 TenGun = o X
file Edit View Comers Chats Window Help 1

L n -Q- 008 Qo @\ @\_ 5 B m u m m Field: | Material | Fitter: % 2
= () Od Cheese

2101d Cheese X #1New Cheese X _ | Recent Folders:
D:\TenGunSamples\Cheese

Al CAD files

Size: 99x 51.9431 x 50. Bounds: X -75.4 t0 23.6, ¥ -27.3431 to 246, Z -254to 24.6. 7
at

2019-04-07 15:39:22.986 Loaded 173,
2019-04-07 15:39:23.012 #11 Point Ci

h 179,195 points. Size: 99 x 52.5033 x 50. Bounds: X -75.4 to 23.6, Y -27.9033 to 246, Z -254 to 24.6.

Key elements of the User Interface (numbered in red) are:
1. Menu Bar. Sub-menus are:

e File. File-related operations and Exit. There are additional items
when in Assembly Mode.

e Edit. Some editing operations.

e Camera. Change the viewpoint.

e Object. Create CAD objects and modify object properties in
Assembly Mode.

e Tools. CAD object and Point Cloud utility functions, for example, to
edit geometry.

e Charts. Create charts.

e Window. Change window settings.

e Help. Display help documentation and program information.

2. Toolbar. Contains buttons you can click to perform some common
operations instead of using the menus.

3. Tree View. There is one root entry for each Panel Tab. You may edit the
name corresponding to a Panel Tab; this will also update the name on
the Panel Tab.

4. Panel Tabs. One tab per set of files. There are two tabs in this example.
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5. Scene Panel(s). Each panel represents the graphics window for one set
of files, with two panels shown here. See Hints at the end of this section
for how to display panes side-by-side.

File Browser (Experimental Feature). This control lets you browse
through the file system for your data. There are three parts:

© N

Hints

At the top is a dropdown list of the folders you have most recently
accessed from TenGun. Using this list is often quicker than
navigating the folder tree. The folder you select may sometimes
appear near the bottom of the tree view.

The middle portion shows tree-structured view of the file system
that you can navigate using either the mouse or the keyboard.

At the bottom is a list of file extension filters that you can use to
limit the output.

Message Window. TenGun logs informational messages in this area.
Status Bar. Shows some User Interface status messages. Of particular
interest is the bottom right corner which displays “File n / m”, indicating
the progress of file reading operations.

e You can change the width of the File Browser by dragging the vertical bar
sideways. You can also entirely hide this from the Window = Show File
Browser menu item.

e When you have multiple files and Keys:
multiple panels open you can navigate [n]: Next frame.
as follows: [N]: Previous frame.

o To change panels, left-click a

Toolbar: Next: |I| Previous: m

Panel Tab, or click on the
corresponding item in the Tree View.

To jump directly to a specific Time Series item, left-click on the
item in the Tree View.

To go to the next item in a Time Series view press ("Next"),
and to go to the previous item press ("Shift Next").

e For a Time Series, Panel Tab title includes “#1”, “#2”, etc. as a hint to which
file in the series you are currently viewing.

e A different icon is displayed in the Tree View for Time Series data ({)) and
Assembly Mode data ().

e To combine scene panels for a side-by-side view, drag the tab for one panel
to the left, right, or bottom edge of the target pane. The target pane will be
split so that you can see multiple models in a single panel.
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e To split scene panels, drag the tab for one panel into the Tab Bar. The
combined model views will be split into individual panels.

e With scenes in a side-by-side view, you can scroll the scenes in parallel by
clicking the | (“Synchronize Scenes”) button on the toolbar. This is very
handy for seeing how different data fields are related. Click the button again
to disable parallel scrolling. When parallel scrolling is enabled the icon
changes from green to red.

e Sometimes you want to compare two sets of results, so you open lots of files
with similar names, but from different folders. You can get totally confused,
just by the names, and you can make it worse if you drag two tabs so that
they appear side-by-side in the same window.

To avoid such confusion, first load one set of files. Next, left-click the scene's
root item in the Tree View. Wait a second, and click again so that the label
will enter edit mode. Change the label to something better than the file name
such as "0Old". Changing the Tree View label will also change the tab label.
Now repeat this for the other set of files, but use a different label such as
"New". Confusion over the file names is now gone even if you rearrange the
tabs.
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Time Series Mode (Post-Processing)

Analysis applications typically generate a number of time step-based particle
(point) output files. The output contains particle positions, velocities, pressure,
temperature, and other relevant analysis results. TenGun is then used to
visually verify those results.

Post-processing features include:

Flexible input file handling.

Filter values using field name and range expressions to display specific
details.

Cut (slice) the results one or more times so that you may inspect the
inside of the model.

Emphasis on ease-of-use, and without a bloated User Interface.

Easily create analysis presentation material.

Animated playback. Play back a series of analysis output files.

Create a movie file from the animation output.

Automated report creation.

Multiple chart types: Frequency Distribution (bar chart or line chart), Line
Chart, Scatter Diagram, and Timeline with statistics.

Save Screenshot to file.

Copy Screenshot to Clipboard for immediate use in another application.
Easily customizable "Display Profiles” that allow definition of user-
specific input file layouts, colors, labels, and other settings.
High-performance, even with large datasets.

Multi-lingual. English and Japanese are currently available.

To use Time Series mode, we suggest that you next review the User
Interface chapter which follows.

TenGun User Guide — 11



User Interface
This section describes key features of the user interface.

File Open

To open a file in the Text Editor, navigate to the File = Open text file dialog.

To open a file for Time Series or Assembly mode display
do one of the following:

e Double-click a file name in the built-in File
Browser, or

e Select multiple files in the built-in File Browser
and press .

e Drag and Drop a file from another application
such as Windows Explorer, or

Keys: [Ctr+O ]

Menu: File = Open
data file.

File Browser: Double-
click.

Toolbar: ?

¢ Navigate to the File = Open data file dialog. Select the file(s) and select

oK

To select multiple adjacent files, hold the key while picking them:; to

select multiple non-adjacent files hold the

key while picking them.

Next, TenGun will display the File Processing Options dialog:

B File Processing Options X

Display Profile: SPHFHDFlow ~

Append to current scene

[ Generate

The File Processing Options are:

o Display Profile. If you are just starting, try the
"Default” profile. Later, you will learn how to
customize the display parameters. Display Profile
settings apply mainly for Analysis Output files,
and are especially important if processing "dumb”

If a CSV or DAT file
does not display, you
may need to customize
the Field definitions in
the profile.

input files containing no field information. For CAD files the profile mainly
only affects the coloring, so you may choose any profile. See also

Automatic Profile Selection below.

e Append to current scene panel. Check this to add the file(s) to an
existing panel; otherwise a new scene panel will be created.
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Generate IDs. Check this to enable the automatic creation of Point ID
data. When your analysis is misbehaving, it is sometimes helpful to filter
by the ID so you can display the properties of particular particles.

Load as separate parts. If this option is checked, CAD files loaded in
Assembly Mode will be treated as separate parts, and each part can be
modified and manipulated with TenGun’s geometry-related tools. If
unchecked, multiple parts are combined into a single object.

Use Extended Reader. This option currently applies only to OBJ and
STL files. The default readers are fast. However, to use OBJ or STL
data with Boolean Operations and other advanced Assembly Mode
features you must use the slower “extended” readers.

Use Background Image. Check this to use the background image as set
in the profile. This is disabled by default because under normal usage it
is rather obtrusive. However, you may want to use a background image
when creating presentation materials.

Read every nth value. This option skips some of the input when
processing text input files. A value of ”1” reads all input, but a value such
as only "5” reads only every 5" value. This is a great speedup, and can
save a lot of memory if you working with huge data files.

View. Select the display mode: Time Series, Assembly, or Text Edit as
appropriate. The available operations depend on this mode, so
remember to select the correct mode.

After selecting , TenGun will try to read and display the data.

Automatic Profile Selection

If you work with many different output file formats, you can set TenGun to
automatically select the correct profile based on a file name pattern. To use this
feature:

Create a text file name C:\ProgramData\TenGun\ProfileMap.dat.

Add one line for each file pattern that you use. Each line should contain
a regular expression (a wildcard pattern) to match the name, a space,
and the name of the profile. For example:

Out-Flow-.....\.dat Flow

The first five periods match any character. The “\.” is an escaped period,
so instead of matching anything, the next character in the file name must
be a real period. When you try to open a file matching this pattern,
TenGun will automatically select the profile named “Flow” in the File
Processing Options dialog.

Blank lines and lines beginning with "#” in ProfileMap.dat are ignored. Also, this
feature does not currently support international characters in the name pattern
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or the profile name.

Notes

e The number of files you can open is limited only by the available memory.

e Wh

en TenGun displays Time Series data, the camera is positioned such

that the entire scene is visible, and the focal point is the center of the scene.
This works fine if the bounds of the scene are the same in each time step.
However, some data is unconstrained (especially Discrete Element Method
output), and the scene boundaries are different at each time step. In this

cas

e, the camera would need to be moved at each time step, but that would

result in rather strange animations. TenGun solves this by computing the
overall bounds of all scenes. When the last file of a series is loaded,
TenGun may redraw the currently visible scene to adjust the camera
position, so don’t be surprised if the current scene suddenly appears to
shrink.

Fields

@ To view details for particle data, select the field name in the "Field" dropdown
list. TenGun will then display a Scalar Bar. For scalar values you can then see
the range of values (e.g., for Density or Pressure), and for discrete variables
you can see the corresponding color legend (e.g., which color represents fluid
or various solid objects).

Field Handling Rules

Field name matching is case-insensitive. Field names may contain
alphanumeric characters and “_”. However, you should avoid using
at the beginning of a name to prevent possible conflicts with TenGun
internal data.

Extra fields in a Profile that are not used in a particular input file are
ignored. You may want to keep extra field definitions in case you work
with a variety of similar data.

If a CSV input file contains an undefined field, TenGun will automatically
add it (temporarily) to the Profile as a float vector. If this is an
inappropriate type, please add an appropriate field definition.

X, Y, and Z (particle positions) are required input fields. These are
implicitly defined in the Profile with a Data Type of "float".

Maximum line size for text input is 4096 bytes; lines are typically 200
bytes long or less.

“ »

Pan, Rotate, and Spin
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You can pan, rotate, and spin the model
using the mouse. Mouse button usage
depends on the type of mouse, but the
Left Button is used for rotation in all
cases.

Zoom

You can zoom in or out using either keys or
the Toolbar buttons.

Camera Position

You can access a Quick Reference guide in
the TenGun Help menu that describes
mouse operation as well as summarizing
keyboard actions.

Keys: Zoom In:[+], Zoom Out: [-].

Toolbar: Zoom in: Q Zoom out: Q

Use the keys and the Camera Menu to
quickly move camera around.

The Rotate actions “x” and “y” rotate the
camera 10 degrees counterclockwise
about the respective axis, while “X” and
“Y” rotate clockwise.

Keys: Top:[Ctr+T], Left: [ Ctrl+L], Right:
[Ctrl+R|, Front: | Ctrl+F|, Rear: | Ctrl+E|,

Bottom: [ Ctrl+B], Rotate +X: |x],

Rotate -X:[x], Rotate +Y:[y], Rotate -Y: [y].
Menu: Camera => Front, Left, Right, Top,
Bottom, or Back.

Toolbar: ﬁ

The 3 (“Home”) button on the Toolbar

can also be used to undo all edits, reset the zoom level, and reset the camera

to the front view.
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View Features and View Type

Use the View menu to display a model

. Keys:
view mode:

b View Bounding Box.

'h| View Spheres.

e Points. Display the model as
points (pixels).

e Spheres. Display the model as
spheres. Spheres in general look [s][s] Toggle Scalar Bar display.
cuter than points, but require . : :

Menu: View = Bounding Box, Points,

mo'_’e prqcessmg power to draw. Spheres, Solid, Vectors, or Wireframe. Also,
e Solid. Display a CAD model asa | Lighting, Scalar Bar.

solid object.

e Vectors. See discussion below.

e Wireframe. Display a CAD model as a wireframe.

e Bounding Box. Add a bounding box around the data. This is sometimes
helpful in visualizing particle flow if the data is not constrained by a
container.

e Lighting. Toggle lighting effects.

e Scalar Bar. Enable or disable display of the Scalar Bar.

You can use the Point Size control on the Toolbar to change Point and Sphere
sizes. Make the points larger to fill in gaps, or make them smaller to peek inside
the model.

Vector View
@ This view displays a field as a scaled vector instead of a point or sphere.

Individual fields may be combined into 2D or 3D vectors. For example, the
three fields VX, VY, and VZ can be combined to create the 3D velocity vector.
These vectors are defined in the General Profile settings. Individual
components of the vector are separated by commas (e.g., “VX, VY, VZ”), and
multiple vectors are separated by semicolon (e.g., “VX, VY, VZ; StressX,
StressY, StressZ”).
Usage is then as follows:

e Select the View = Vectors menu item or press :
Choose the vector to use.

e Set a scale value.

e Select .

TenGun then normalizes the selected vector magnitudes to the range 0 to 1.
For each field value, a line is drawn from the field’s position in the direction of
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vector. The length of the vector is controlled by the “scale” value in the settings
dialog. Note that the scaled vector length is in “World Coordinates”, so you may
need to make the scale value small if the particles are small.

In general, you use coloring to highlight features of your data such as
temperature or density. The Vector View feature can sometimes be combined
to make interesting graphics that show not only something like temperature, but
the particle flow.

TenGun User Guide — 17



Filters

@ Filters allow you to display a subset of the input data. To apply a filter, enter a
Filter Expression in the Filter area on the Toolbar and press | Enter | TenGun
remembers your most recent filters, which you may select from the dropdown
list instead of typing the expression again.

A Filter Expression is of the form:
field relop constant

where:
e field is a Field Name. Field names are case insensitive.
e relop is a relational operator: < (less than) <= (less than or equal), =
(equal), '= (not equal), >= (greater than or equal), and > (greater than).
e constant iS a constant numeric value.
Examples:
Pressure > 1.5

Material = 3

You may use multiple expressions by separating them with the logical operators
"and" and "or". For example:

material != 1 and density > 0.95

Expressions are evaluated left-to-right. You may currently not group sub-
expressions using parentheses.
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2D Cut

O You can look inside a model using the 2D Keys:
(Plane) Cut feature: c|[x]: Ccut left.
c||X]: Cut right.
. . C : Cut below
e Select one of the Cut directions as . : Cut above
shown in the sidebar. c|[z]: cut front.
e A yellow plane is displayed c|[z} Cutrear.
perpendicular to the cutting direction. i]: Invert cut direction.
There are two ways to move the cutting PrYe
lane: Toolbar; 00 & for cx, cy, and
P : i cz. Press Shift while clicking to
o Left-click and drag on the plane. use cX, cY, or cZ.
This method easy and helpful

when you just need a rough cut. You may need to rotate the
model slightly in order to grab the plane.

o Or, directly set the boundary e ot Lt e
values in the “Plane Cut” dialog.  s<eee
This method can be used when | ¢Range: 4GTE3 o 3675 '
you need a more precise cut. .

e A normal vector is also drawn through
the plane pointing in the direction of the
portion to be preserved after the cut.

e You can rotate the cutting plane by dragging one of the cones on the
ends of the normal vector.

e Press to complete the cut, or press to cancel.
e Undo a cut operation by typing | Ctrl+Z s or from the Edit ©® Undo menu
item.

The 2D Cut feature is currently not available in Assembly Mode.
2D Cut Example

The image on the left shows show the screen after typing the (“Cut right”)
command. The cut will be made at the Clipping Plane, and the portion in the
direction of the Normal Vector is preserved. The image on the right shows the
result.

Clipping Plane G
N o
|
|
|

0

| Normal Vector
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3D Cut

@ The 3D Cut feature allows you to cut out Keys:
portions of an object so that you may view the [c][v] cut Volume.
inside. To use this feature: [i: Invert cut direction

(toggle between inside
and outside).

¢ If you are in Assembly Mode, select the
object of interest by Right-clicking it.
e Type (“Cut Volume”).
e A bounding box is displayed around the object and the “Volume Cut”
dialog is displayed.
e There are two ways to select the desired volume:
o Use the six round “handles” on the outsides of the bounding box.
Left-click and drag any of the handles to move the associated face
in or out. This method easy and helpful when you just need a
rough cut.
o Or, directly set the boundary values
in the Volume Cut dialog. This [E—
method can be used when you need @

XMin: 7467450

a more preCIse CUt XMax:  69.467499
e Type m (“invert”) to toggle the selection
direction. This allows you to keep the
outside of the bounding box instead of the S Mo
|nS|de ZMax: 1250069946
¢ When you have enclosed the area of el — =

interest, press | Enter | or click the OK button. To cancel the operation
press | Esc | or click the Cancel button.

e Undo a cut operation by typing | Ctrl+Z | or from the Edit = Undo menu
item.

Hints

e 3D Cut is especially useful when creating Point Cloud. Some portions of the
model can often be removed to reduce the number of particles in the
analysis without having any effect on that analysis.

e In Time Series Mode, a 2D-Cut is applied to all members of the Time Series.
At this time, a 3D-Cut in Time Series Mode is applied only to the current
Time Series item. This behavior is likely to change in a future version so
that the cut is applied to all Time Series items.

3D Cut Example

The left image shows an exhaust manifold with 3D-Cut actve. The top and the
rear handles are moved down and in to remove the flanges. The right image
shows the result after cutting.
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Screenshots

You can make screenshots in the
following ways:

e Press|Ctrl+S|. You will be

prompted for the name of a file to
save the screenshot in. You may
also select the file format (BMP,
JPEG, PNG).

Press | Ctrl+C |. The screen image

Hint: Screenshots taken on a wide screen
will generally have a lot of empty space. We
suggest that you resize the TenGun window
so that the scene area has an aspect ratio
of approximately 4:3 (1.333). This aspect
ratio is displayed in the Message Window
as you resize.

This advice also applies to creating reports
and animation. Use the Window > Reset
Window Layout menu item to restore the
size to the default.

is placed in the Clipboard, and

from there you may paste the
image into some other documentation.

Animation & Movies

® To create an animation:

Keys: [a ]to start, to stop.

Open two or more files. Analysis Toolbar: Start: [ stop: [J.

programs typically create the output files
with a sequence number such as output001.csv, output002.csv, etc.
The first file will be loaded immediately,
and additional files will be loaded in the
background. NOTE: You can see the
file loading progress by observing the
Status Bar. The bottom right corner of
the screen shows a load progress
message, such as "File 15/ 20", which
indicates that 15 out of 20 request files
have been loaded.

Optionally set a custom title message. See Animation Settings.

Type @ or click the @ (“Play”) button on the Toolbar. This functionality is
disabled until at least two files have been loaded.

The first time a file is displayed, TenGun will display the underlying
graphic data, and it will also create an image file of that data. If you
continue playing the animation, the image file is displayed instead of the
graphic data, which is considerably faster. The first pass is therefore
likely to be relatively slow, but subsequent passes are more likely to
match the per-scene Animation Time that you have specified.

The Animation playback time can be set in the Animation Settings. The
default time is 200 milliseconds between screens.

To stop playback press , or press the Stop Animation button in the
Toolbar.

Image files are stored in the
"TenGun_Animation_datetime"
subfolder where the input data
resides. This folder will be deleted
whenever you open a new input
file or when you exit TenGun. If
you want to keep the bitmaps,
copy them before you do one of
these actions.

To create a movie;
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Notes

First create the animation data as described above.

Select the File = Save Animation as Movie menu item.

Enter the movie file name. The file type can be “avi’, “mp4”, or “ogg” as
indicated by the file extension. The “mp4” and “ogg” formats are
supported in a web page in a <video> control. The “ogg” format tends to
be the smallest but is not supported by Safari as of this writing. If you set
the type to “all’, TenGun will create movies in all supported formats.

Select OK to create the movie.

When animation starts, the Scalar Bar range for continuous variables is
calculated from all of the data that has been loaded so far. This is done
so that the Scalar Bar shows the variable range for the entire simulation
rather than the range for individual scenes. If the exact range is
important to you, you must wait until all files have been loaded.

The default “on” behavior is to use the overall minimum and maximum
values from all scenes in the Scalar Bar. The[s][a]command can be
used to toggle this behavior. When “off’, the minimum and maximum of
individual scenes is used instead.

While animation is active you may not perform any actions that affect
scene layout such as zoom, filter, and so on. Therefore, you should set
up the display exactly as you want it before you start the animation.
TenGun creates movies by running the command file
“C:\ProgramData\TenGun\CreateMovie.cmd”. This command file is
responsible for running a separately installed third-party application such
as the open source FFmpeq. This application then converts the
animations images created by TenGun into the desired movie file format.
Feel free to customize this command file to meet your requirements.

Some media players including Windows Media Player or VLC
automatically play a movie when it is opened, and often do not display
the very beginning. If this occurs, rewind the movie and replay from the
beginning. This problem does not occur with the ffplay player included
with FFmpeg.
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Charts
@ You can create these types of charts:

Distribution Chart. This calculates a Frequency Distribution and displays
it either as Bar Chart or a Line Chart. Multiple variables may be selected.
Line Chart. You may plot a single variable along X-Axis to plot against
one or more variables on the Y-Axis. Either axis may be plotted using a
logarithmic scale instead of the default linear scale, although the internal
charting code may sometimes override your choice.

Particle History. This plots time-series values for one or more variables
and one or more particles. For points you may specify:

o A single point. Point IDs start at 1.

o A point range where the values separated by a hyphen (e.g. 2000-
2005).

o Multiple points or point ranges separated by a comma (e.g.
100,200-204,300).

The point set is initialized to the most recent five points that you have
selected with the Point Picker.

Scatter Diagram. Same options as for Line Chart, but X-Y pairs are
presented as dots instead of lines.

Timeline Chart. This plots a time-series for one or more variables for the
selected statistic(s). Available statistics are average, maximum,
minimum, and standard deviation. This chart is useful for fields such as
Equivalent Stress where only the maximum value is actually useful.

To create a chart:

Open a Time Series view. Particle History and Timeline Charts require
that you open multiple files.

Select a chart type from the Charts menu. The data source is in the
Time Series data, so you cannot select a chart type from an Assembly
Mode or from a Chart view.

Fill in the parameters appropriate to the chart. Minimally this involves
selecting the field(s) to be displayed in the chart.

Select [OK]. The chart is displayed in a new tabbed pane.
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Timeline Chart Example

The following shows the setup dialog for a Timeline Chart for a stress analysis
and the resulting chart.

Plate with Pressure

Timeline Chart Setup % 5000

Title: Plate with Pressure 8000-

Time Scale: |4 7000-

Fields Average Maximum Minimum  StdDev

[]ax ~
Ay

(laz

[1Bound

[ Density

[JEPEqQV

] Material

[ Pressure

STEqw

[ StrainX

[ StrainY

[ 5trainZ

[ stressx

[ StressY

[ Stressz

[ Temperature
Cvx

vy

vz

Ox v

6000-

2
8
8

STEQY (Viaximurm)
]
g

2000.

1000-

Time:

aAOaaaaaaaanaaaaaaaaaa9
A0 aa”daaaaaamann
aAaaaaaaaaananaaanaaaamann
aAaaaaaaaaananaaanaaaamann

[~ ¥-Axis Log Scale

oK Cancel
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Reports
@ TenGun can create a report, with graphics, of your data. To do so:

e Open a file or a file series.

e Optionally set a Filter.

e Select the File = Create Report menu item.

e Enter a report file name and optionally a description. The description is a
good place to enter notes about conditions used for this analysis.

e Select the file type for image files (BMP, JPEG, or PNG).

e Select the fields you wish to report on.

e Select one or more object faces to be used to create graphics (Front,
Back, Left, Right, Top, Bottom).

e Check "All Scenes" to include all scenes of the time series in the report.
If unchecked only the current scene is included.

e Select[OK].

TenGun then moves the camera as required, cuts the model in half, and takes a
screenshot for each selected face.

The generated report file can be viewed by any HTML5-compatible browser.

Report Setup Example

The Report Settings dialog is shown below.

Report Settings x
Report File: | DACAD\SampleData\cheese-5.snapshot.1\Ssmple.html [T
Description: | Analysis Resuls - High Velocity Settings |
Imagetype: PNG ~

Views

(ATop [AFront [ARight [CBottorn [JLeft [Back [l Scenesd
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Object Picking

picking behaviors: edges), [p |[f | (pick faces), or[p |
(pick vertices) to enable picking mode,
e Points. The Point Picker displays all [Esc] to tum off picking.
properties for the nearest selected Mouse: Left-click to pick a point, edge, or
point in popup "palloon". (TO hide face. Right-click to pick an object. To

select multiple items hold the | Shift | key

the balloon, move the mouse
pointer.) Use the Zoom, Rotate, and Cut functions as necessary if you
actually need to pick a specific point.

Edges. Pick edges of a CAD model.

Faces. Pick faces of a CAD model.

Vertices. Pick vertices of a CAD model.

Object. Right-click an object in Assembly Mode to select it, and the
object is then highlighed. You may use the Geometry Editor to change
position, scale, and rotation of individual objects. And, you may combine
multiple objects using Boolean Operations. You may also select objects
via the Tree View, which is sometimes helpful when one object obscures
another object.

To select multiple objects, press while clicking. To deselect an object,
click it again.

Hints

e To rotate an object while picking is enabled, move the mouse pointer outside
of the object to a blank area. While pressing the left mouse button, move the
mouse point to rotate the object.

Hide Object

You may sometimes wish to hide an object, especially when you want to edit
one object contained inside another object. To do so:

¢ Navigate to the object that is in the way type typing ("Next"),
("Shift Next" for previous), or by clicking the object in the Tree View.

° Type (“Hide”).

To restore visibility, navigate to the hidden object and type again. You can
also unhide the object by clicking it in the Tree View.
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Pick Interior Face

Sometimes you need to select an interior
face of a CAD object so that you can set
properties such as a boundary condition.
To do this, first enter Pick Face mode as
previously described. Next, you normally
click an exterior face. However, to select

the “nth” face behind that exterior face, type

a number (1 to 9) before clicking the
exterior face. The most common case is

that you type “1” to select the inside of a wall, and from there you can set
properties for that inside wall using Edit Part Properties (refer to Assembly
Mode (Pre-Processing) for details on setting part properties). Ordinary behavior
is restored by typing “0”, or by restarting Pick Face.

Distance Measurement

Use the Distance Measurement feature to
find the distance between two points:

e Start or restart measure mode by

pressing [m].
e Click the starting point.

Keys:[m| Press to turn off

measurement.

Mouse: Drag the handles of the ruler to
move the two endpoints.

e Move the mouse pointer and click again to establish the second point along

a “ruler”.

e TenGun “snaps” the points you selected with the mouse to the nearest
points in the actual points in the data and displays the distance.
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Profiles

A "Profile" contains information describing Field Menu: Edit > Settings.
properties such as the data type (e.g., integer, float), )
labels for scalar bars, and coloring information. Toolbar: 4.

General Settings

Settings are:

Text Color. The color for text messages. Double-click the color to display
a Color Picker Dialog.

Background Color. The background color for text messages. As above,
double-click the color to change it.

Background Image. The name of an image file that can optionally be
added to Time Series displays. Whether or not this is actually used is
determined by an option in the File Processing Options dialog.

Font Name. The name of the font to use. Most TrueType™, OpenType,
and FreeType fonts can be used. (Some of these do not work with the
graphics library, so you may have to experiment a bit.) Double-click the
font name to change it.

Point Color. This is the color to use for points when a color table is not
assigned.

Selected Object Color. This is the color to use for selected vertices,
edges, faces, and objects.

Unselected Opacity. When an object is selected, the opacity of the other
objects can be changed. This allows you to see the selected object
through any containing objects. The value range is 0.0 for fully
transparent to 1.0 for fully opaque.

View Type. Sets the default point view type such as Points or Spheres.
Point Size. Sets the default point size from 1 to 99, with 1 through 10
being common.
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e Default Field List. This list defines the names of fields for simple data
files that do not contain any field definitions. Field names are separated
by commas.

e Default Field Name. If this item is set, TenGun will automatically select
this field whenever you open a file using this profile.

e Size Field Name. TenGun supports variable point size display which is
useful for displaying Discrete Element Method (“DEM”) and Molecular
Dynamics results. The Size Field Name is the name of a field in the
output data containing the particle size, for example “Radius”.

To display such data, TenGun converts individual points into spheres of
the associated radius. Additionally, TenGun clones properties from each
particle such that if you do Point Picking anywhere in the sphere, it will
report the information for the original field data. The “Point Number”
displayed will no longer match because there are now more points.
However, if the input data has an “ID” field, the original ID will be correct
no matter where you click on the sphere.

This feature can generate a significant amount of additional data, so it is
not intended to be used with huge point clouds.

e Point Quality. The value sets the number of subdivisions used to create
the graphic representation of each sphere. A setting of about 5 ~ 10 is
not beautiful, but reasonable when you are just verifying your analysis
run. Then, before for making presentation material you can raise this to
a higher value such as 20. Note, however, that this setting only takes
effect for newly loaded data, so you cannot change it for a scene that is
already being displayed. If the Point Quality is set to 0, TenGun uses the
normal Point Size setting to display a scene, and ignores the “Size Field”
setting. Finally, for higher quality output, you can display the scene using
a Solid View instead of the usual Sphere or Point View used for particle
data.

e Vectors. Vector definitions for Vector View mode. Refer to Vector View
for details.
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Continuous Scalar Colors Settings

S_calar _CO|0r settings are used When Note: The Scalar Bar Labels and Scalar
displaying the Scalar Bar for continuous Bar Label Format on this screen apply to

variables such as Density or Pressure. the Default Scalar Color Table. The
equivalent settings for the non-default

case can be made on a field-by-field basis
in the Fields editing screen.

Setup - Cheese
General } Scalar Colors | Discrete Colors Fields  Charts  Animation

Table: (Default) v Add Table
s ]

Colorfor Maximum Volue: N i
Number of Colors: =

Scalar Bar Labels: =

Scalar Bar Label Format:

oK Cancel

Settings are:

e Table. Used to select a specific Scalar Color Table. Use the Add Table
Button to add a new table, and use the Delete Table Button to delete the
selected table.

e Color for Minimum Value. Scalar colors are based on a color wheel
concept. Red, Green, and Blue are at 0, 120, and 240 degrees
respectively, wrapping back to Red at 360 (0) degrees. The "low" and
"high" colors therefore select the starting and ending points on the wheel.
Double-click the color to display the Color Picker Dialog.

e Color for Maximum Value. The "high" color as explained above. Double-
click the color to change it.

e Number of Colors. Sets the total number of colors. A color gradient with
this many entries (e.g., 64 colors) will be created for values between the
minimum and the maximum.

e Scalar Bar Labels. Sets the number of labels to display on the Scalar
Bar when using the Default Scalar Color Table.

e Scalar Bar Label Format. This specifies how floating-point values are to
be displayed. See Scalar Bar Label Format below.
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Scalar Bar Label Format

A format specifies how floating-point values Users familiar with "C" will nofice that

are to be displayed, and must be of the form: this is a "printf" format string without
the % sign.

[flags][width][.precision]specifier
where:

o "flags" are optional modifiers. "+" forces the display of a plus sign for
positive numbers, and "-" causes the output to be left-justified.

e "width" specifies the minimum display width. If the formatted string is
shorter than this it will be padded with spaces.

e "precision" specifies the number of digits to display after the decimal
point.

e "specifier" specifies a style. Styles can be: e (scientific notation), f
(decimal floating-point), or g (best fit). "Best fit" means use floating-point
format if there would be many trailing zeros, otherwise scientific notation.

The default format is "-6.5¢g".
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Discrete Colors Settings

Discrete Colors Tables are used when there are a limited number of possible
values for a field. For example, an analysis model typically has only a few
different materials. In this case you can use a Discrete Colors Table. This maps,
one-to-one, each material to a different color. Materials are then easy to
distinguish during visualization.

aaaaaaaa

eeeeeeeeee

Opacity Dresets.

tttttt

Settings are:

e Table. Used to select a specific Discrete Colors Table. Use the Add
Table Button to add a new table, and use the Delete Table Button to
delete the selected table.

e To add a predefined color set, click the Presets Button and select one
of the many predefined color tables.

e To add colors individually, click the Add Color Button.

e To delete a color (1) select it by clicking the color number in the left
column, and (2) click the Delete Color Button.

e To change a color, double-click on it. The Color Picker Dialog will be
displayed.

e Opacity. Values can range from 0.0 (totally transparent) to 1.0 (totally
opaque). You may be able to obtain some interesting display effects
for your scene by changing this value. For example, if you have a
scene with water and gas bubbles, you can lower the opacity for the
water so that the gas bubbles are more visible. Double-click a value

to change it. Then press to complete the edit, or to
cancel.

In this sample screen we have already added a Field named “Material” on the

Fields tab, and here in the Discrete Colors tab we define the color scheme for
material 1 through 4.
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Field Settings

This screen is used to define the details of data fields in your input files.

nnnnnnnn

ggggggggggg

cccccc

Settings are:

Field. This dropdown list contains the names of available fields. The
sample profiles contain a number of common fields such as AX, AY, and
AZ for acceleration, VX, VY, and VZ for velocity, and so on. Use the Add
Field Button to add a field, and use the Delete Field Button to delete a
field.

Description. An optional description of the field.

Display Text. If this is set, this text will be displayed in various places
instead of the field name. For example, if you have a field named "P",
you might want to actually display "Pressure".

Content Type. The selected value indicates how this item is related to
the model, for example, the data is related to "Acceleration”, "Velocity",
"Stress”, etc. This is currently unused, but may be used in a future
version to provide additional analysis capabilities.

Content Detail. This specifies the English name of the content. It is
currently used in handling variable particle sizes so that we can
determine that the field named “R” is actually a radius, or the field named
“Phi” is a diameter. Allowed values are “Radius” and “Diameter”.

Data Type. Specifies how the data should be stored internally. Possible
settings are:

o byte. 8-bit unsigned integer. Range: -128 to +127.

o double. 64-bit floating-point. Range: 2.225 E=3% to 1.797 E38 with
approximately 15 digits of precision.

o float. 32-bit floating-point. Range: 1.175 E-38 to +3.402 E=8 with
approximately 7 digits of precision.
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o int. 32-bit signed integer. Range: -2,147,483,648 to
+2,147,483,647.

o long. 64-bit signed integer (in "C" this is really called a "long
long"). Range: -9,223,372,036,854,775,808 to
+9,223,372,036,854,775,808

o short. 16-bit signed integer. Range: -32768 to +32767.

o string. A character string in UTF-8 format. Currently of limited
use in TenGun.

o uint. 32-bit unsigned integer. Range: 0 to 4,294,967,295.

o ulong. 64-bit unsigned integer. Range: 0 to
18,446,744,073,709,551,615.

To conserve memory you should try to use Data Types that are as small
as possible but still contain the range of your values.

Discrete. This option can be used for fields that contain a limited number
of different values. (Up to about 10 is reasonable). This option instructs
TenGun whether to use Scalar or Discrete Colors Table.

Scalar Bar Labels. Number of labels to display on a Scalar Bar for this
field. Please refer to previous discussion.

Scalar Bar Label Format. The display format for this field. Please refer
to previous discussion.

Scalar Bar Minimum. TenGun normally | \when displaying a Time
uses the actual minimum and Series, you may temporarily
maximum field values to set the Scalar | change the minimum and
Bar range. You may set fixed limits by | maximum values by

setting the minimum and maximum pressing @ These

(see b_elow). To reset the normal settings are not saved in the
behavior, set both values to 0. profile.

Scalar Bar Maximum. Maximum value
for the scalar bar range as explained above.

Color Table. Use this to select a particular Color Table to apply to this
field.

Units. You can set the units to display on the Scalar Bar for this variable
such as “m/s” or “MPa”.

In this screen we have defined a discrete integer field named “Material”, and
have added labels for each of four possible values.

For discrete variables you can specify value/label pairs. The value depends on
your particular data, and will be a field value such as a Material number. The
corresponding label is displayed on the Scalar Bar. Double-click a label or value

to change it. Press to complete the edit, or to cancel.

When a discrete variable is a floating-point type, the meaning of the “value”
changes. Rather than being a fixed value, it becomes an upper limit. For
example, for a stress field, you might set values of 0.0 (lower limit), 1000.0,
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2000.0, and 3000.0 (upper limit) to define four ranges that are used to select
one of four colors from a Discrete Color Table. Where this becomes interesting
is if you adjust the opacity in the color table. For example, to make high-stress
areas easy to see, set the opacity to lower values (e.g., 0.1) for stress levels
that you are not interested in, and set the opacity to a high value (up to 1.0).
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Chart Settings

Setup - Cheese
General Scalar Colors Discrete Colors  Fields ~ Charts  Animation
Ted Color: Sample App

ackground Color: Sample

B
Pen Width: =

@& Presets...

Add Color

Delete Color

o ~o v e w o

oK Cancel

Settings are:

Text Color. Color for labels in the chart.

Background Color. Chart background color.

Pen Width. Width of lines in a chart.

Color Table. One color for each possible variable. If there are more

variables than colors, colors will be reused starting from the beginning of
the table.
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Animation Settings

Settings are:

e Animation Time. The number of milliseconds between animation
frames.

e Title. Text to display in the animation screen. The text may include
the following macro values:

o %D Current date.

o %E Elapsed time.

o %F File name.

o %P Number of points (particles).
o %S Animation step number.

o %T Current time.

e Elapsed Time Scale. TenGun multiplies the time step number by this
scale value to arrive at the elapsed time. In many simulations, one
output file represents the results after a number of simulation steps.
For example, the time step may be 1 microsecond, but the data is
written only every 1000 steps. In this case the time scale value would
be set to 0.001 (0.000001 seconds x 1000 steps).

e Elapsed Time Format. This is a format string that you will want to
adjust depending on the Elapsed Time Scale. For example, for the
above Elapsed Time Scale example, the smallest time will be 1
millisecond. In that case you can set the format to “.4.3f” which will
display 3 digits after the decimal point. Refer to Scalar Bar Label
Format for format string details.

e Showcase Mode. After displaying a time series you can rotate the
camera around the object to showcase the final product. The mode
can be either “None”, “X-axis Rotation”, or “Y-axis rotation”.
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e Angle Increment. Showcase Mode increment in degrees for the
rotation. A positive value moves the camera counterclockwise, and a
negative value moves clockwise.

e Maximum Angle. The maximum angle for Showcase Mode. This will

normally be 360°, but can be less for a partial rotation, or more if you
want to rotate several times.
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Help
The following information is available from the Help menu item:

e Documentation. Displays this file.

¢ Quick Reference. Displays keyboard and mouse usage information.

e Release Notes. This contains program update history and known
limitations.

e About This Scene. Displays metadata for the current scene.

e About. Displays TenGun program and license information.

Additional Documentation

The following documentation is also available in installation folder under the
Docs subfolder:

e EULA-eng.rtf. The End User License Agreement.

e ThirdPartyLicenses.pdf. This file contains license information about Open
Source libraries used by TenGun.
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Assembly Mode (Pre-Processing)

TenGun can create input data for various analysis applications. This typically
involves converting multiple CAD files to particle format, and then adding
application-specific parameters such as timing control, material properties,
boundary conditions, and so on. TenGun encapsulates these pre-processing
activities with a few simple operations.

Pre-processing features include:

¢ Read a number of CAD format files including IGES, OBJ, PLY, STEP
(1ISO 130303-203 and 130303-214), and STL.

e Convert CAD models to analysis-application input format.

e Convert a CAD mesh to a point cloud.

e Edit CAD object geometry.

Assembly Mode usage is explained in the remainder of this chapter.
NOTE WELL: Assembly Mode requires a “Professional” license. If you do not

have such a license you will still be able to explore features related to Assembly
Mode. However, you will not be able to save any related files.
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Generating Data

the st¥ TenGun can create some basic object
shapes that can be used to create an analysis
model. To do so:

e Open an Assembly view by creating
and empty view with File=>New
Assembly or by opening a CAD file in
Assembly Mode.

¢ Insert one or more objects from the
Object menu. Available object types
include:

o Box (Cube). The box may have
either one or two open faces.

o Cone/Frustum. Creates a cone
or frustum.

Keys:

Menu:

E: Next object.

N | Previous object.

s | Toggle selection of all
objects.

[Del]: Delete object.

Ctrl+N | New Assembly.
Ctrl+G |: Edit Geometry.

File > New Assembly.
Object => Insert Object.
Object = Duplicate.
Object > Delete Object.
Tools = Difference.
Tools = Intersect.
Tools = Union.

Tools = Edit Geometry.

o Extrusion. Create a 3D object by extruding a 2D surface. See

Revolved and Extruded Surfaces.

o Pipe/Circle. An open-ended cylinder. You may optionally add
caps to either end. Setting the pipe length to O will create a 2D

circle.

o Revolution. Create a 3D body of revolution from a 2D surface.
See Revolved and Extruded Surfaces.

o Solid Plate. You will be prompted for the dimensions. One of the

dimensions can be 0 to create a 2D plate.

o Solid Disk. You will be prompted for the dimensions. Setting the

depth to O will create a 2D disk.

o Sphere. A spherical object (hemisphere by default).
o Torus. You can create a full torus by specifying an Angle of
Revolution of 0° or 360°, or a partial torus by specifying some

angle in-between.

o Wedge. Creates a solid wedge or pyramid-shaped object. The X
Min and X Max values specify the top left and top right vertices of
the face in the X plane. Similarly, the Z Min and Z Max specify the
top front and top rear vertices of the face in the Z plane. If all of
the X, Y, and Z-related values are the same the result is a cube.
Changing these values therefore allows you to generate a number
of different shapes. For example, you can create a pyramid by
setting X Min and X Max to half the width, and Z Min and Z Max to

half the depth.

e Duplicate. Creates a duplicate of each selected object. Duplicated
objects are inserted to the right of the original; from there you can move

them as required.

¢ |In addition to inserting objects as described above, you can open a file

and append it to an existing view.
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e The default size of each object is such that the length, width, and/or
height are 200mm. This is a practical size for a part that you might
analyze with millimeter-sized particles.

e For many objects you can set a wall thickness that by default will be a
few particles thick. For round objects such as a Pipe, the wall thickness
is implied by the inner and outer radius. The wall thickness concept is
used to control the strength of a fixed boundary versus free-flowing
particles in an analysis.

e To create objects that are completely full of particles and do not have
empty space inside:

o Boxor Cone: Set the wall thickness to 0.
o Pipe, Sphere, or Torus: Set the inner radius to O.

With these basic shapes you can create a number of objects that are handy in
particle analysis such as:

e A box or pipe with openings can be used as a particle container, and a
plate can be used to compress them.

e A solid box might be used to represent ice in a liquid.

e Torus segments can be used as a rounded pipe segments.

¢ A frustum with open ends can represent a funnel. The funnel can
contain material that is injected into some other part of the system. This
case can be used, for example, to represent a 3D printer head, a medical
device, or a portion of a die casting system.

e Basic shapes can be combined with Boolean Operations to create more
complex objects.
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Revolved and Extruded Surfaces

To create a body of revolution from a 2D surface, select Object-=>Insert Object
=>Revolution. The following dialog will be shown:

m Create Revelved Surface

X-Y Coordinates:

Auis of Revolution

Ox ®y Oz

Angle of Revolution (degrees): l:l

00
100
15,10
13,10
82
02
0,0

Cancel

Fill in the values:

¢ Angle of Revolution. The number of degrees to rotate the surface. An

angle of 0° is treated as 360°.

e X-Y Coordinates. Input the X-Y coordinate pairs for the surface, one per
line, with values separated by a space or comma. You need at least
three pairs to create a surface. An unclosed surface will result in a shell

being created.

e Axis of Revolution. Select the axis around which to rotate the surface.
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The above input will create a bowl:

Creating an extruded object is nearly the same. Select Object=>Insert Object->
Extrusion. A dialog similar to the Create Revolved Surface dialog will be shown
(omitted here to save space). The main difference is that you must input the
extrusion length rather than an angle.
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Part Colors

To change the coloring of assembly parts, create a Discrete Colors table named
“Assembly”. The first part inserted uses the first color, the second part the
second color, and so on. If there are more parts than colors, TenGun cycles
through the table from the beginning.

The dialog for extrusion is quite similar and not shown here, except for extrusion
you input the extrusion length instead of an angle.
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Exporting Data
& This section describes the two ways that TenGun can export data.

Export Model as Point Cloud

& This feature can convert solid
models in the current scene to a point
cloud. Any existing point cloud data in
the scene is ignored during the conversion.

Menu: File = Export = Model as Point Cloud.

Experimental Feature

To create a point cloud of the model | 8 o cousecing: x
|tse|f you On|y need to Set the P0|nt Size: 63.7788 x 72,1204 x 67.4801. Bounds: X 646745 to 70.2463, Y -158.522 to -86.4016, Z 1184.07 to 1251.35.
Size. A point cloud is created where
points fill all of the model’s surfaces.

Point Size: 1

Gro
The “Use mesh scanner v2.5” option |-
attempts to cover all surfaces with Crese SnglePartcterom Group
particles. The legacy algorithm is ettt ‘
similar, but it tries to identify solid
walls, ignoring the empty space N
between those walls. 3 By Bz

Qutside Spacing
Front Back:

up Volume Distribution:

Minimum wal Il thickness:

Maximum wall thickness:

The newer algorithm works better for | e
objects that do not have explicit solid | ., . e
walls such as OBJ and STL meshes.

oK Cancel

The following settings allow you to create particle groups that can represent
clumps of materials of different sizes:

e Group Sizes. This is a list of one or more cluster sizes separated by
spaces or commas. When set, the Point Size value becomes the
minimum grid size, and each of the values in this list is the diameter of
the cluster. For example, if the Point Size is set to 100 (perhaps in
microns), the Group Sizes might be 100, 120, and 140. Values must be
>= the Point Size.

e Group Volume Distribution. If Group Sizes is set, this field contains the
desired volume distribution for each of the groups (e.g., 25, 50, 25)
expressed as a percent of the total volume. Values are comma or space
separated.

e Create Single Particle from Group. When unchecked, a “group” will
consist of one or more patrticles of size “Point Size” organized as a
sphere. This organization is suitable for SPH analysis. When checked,
the group is output as a single sphere, which is more suitable for DEM
analysis.
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e Random Number Seed. Particle groups are placed randomly. If you do
not specify a Random Number Seed, the same input will generate the
same output. If you actually want to generate a different distribution, set
this to a different seed. Remember to make a note of your seed values
SO you can reproduce the same output if necessary.

When generating particle groups, TenGun creates the Point Cloud file for the
entire model, and one additional Point Cloud file for each Group Size. The
individual files can be imported back into an assembly, and then exported once
again when creating Analysis Data.

For simple objects, the default wall thickness settings are usually appropriate.
Complex objects, however, may require some experimentation with these
settings:

e Minimum wall thickness. When this value is non-zero, the algorithm will
ignore short solid segments so that the segment will not be treated as the
start of a wall. While scanning a cylindrical object, for example, most of
the time the scan detects going inside the cylinder, some empty space,
and then the other side of the cylinder. While scanning the extremes of
the cylinder, however, the scan never actually goes inside. Note that the
units are points, so you may need to convert the wall thickness in your
model (e.g., millimeters) to points to find a good value.

e Maximum wall thickness. This is similar to the above, but instructs the
scanner to discard false walls. A false wall can occur if there are
overhanging portions of the model such as flanges.

e Scan Direction. The scanning needs to find wall entrance and exit points
in order to decide if there is empty interior space. By default, the scanner
does this in three dimensions. In some cases, you can scan in only one
direction to speed up the point cloud creation. For complex objects, you
can sometimes improve the output by scanning in only one or two
directions. (See examples below.)

Output quality is also affected by the quality of the input.

Finally, for interior point clouds you can set the Outside Spacing to shave off the
specified number of particles in n the specified direction(s). Use this option to
prevent filling the object entirely. For example, if you have a container of liquid,
you may not want to fill it exactly to the top, so you with set the “Top” value to
several particles. This option is also useful in particle analysis to prevent
particles from initially being too close to walls.

Point Cloud Interior — Simple Example
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This cup example works well with interior point creation.
The cup is actually upright, but has been rotated so that
you can see the inside.

Scanning in the all three directions works with no
problem. Note, though, that the Y-direction scan does
not detect anything because it only finds one wall.
Therefore, the scan could actually be done only in the X
or Z direction.

Also, this is a perfect example of where “Outside Spacing” can be used. Setting
the “Top” value prevents the cup entirely to the brim.

Point Cloud Interior — Complex Example

This exhaust manifold is a nightmare:

We don’t want to include the holes in the
flanges as interior space, but scanning
horizontally this case looks like wall-empty-
wall.

Scanning vertically, the flanges look like the
start of a wall, but we don’t want to treat them as walls.

We don’t want to treat the empty horizontal space between the upper
pipes as interior space.

You can’t see it here, but the upper pipes are tapered. They are thicker
near the flanges than near the middle.

The following steps allow you to create a reasonable (although not perfect)
approximation of the interior:

Cut off the flanges with the 3D Cut function. The flanges are probably
irrelevant to the analysis anyway.

Scan only in the Y and Z directions. This avoids a false wall problem
between the pipes in the X direction.

The result leaves some slight artifacts caused by the tapering of the pipes—a
challenge left for a future version.
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Export Analysis Data

& This feature combines all of the objects on the current panel to create input
data for a third-party analysis program. When opening the files, pay careful
attention to the "Load as separate parts" Open option as this will affect the
number of generated parts.

Operation is as then follows:
e Apply part properties to each part in the scene:

o Select an object. If no part has been selected, the first part will be
selected automatically.

o Invoke the Edit Part Properties Keys: [e][p] (Edit Part’ properties).
function. The first you will be
prompted for an “Export Menu: , .
Template”. iject - Edit Part Propertles.
File = Export Analysis Data.

The template is specific to the analysis program you wish to use.
The standard installation includes only a sample template
“SampleApp.export” that you can use to learn how to use this
feature. Please contact us for information about templates that we
have developed or about how to create your own template.
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o Set the appropriate property values. e *

Material 1

Again, this is specific to the target o 1
application, but typically includes settings | & :
for the material type, boundary condition,
velocity, static load, and so on.

o Experimental Feature. You can use Edit
Part Properties on faces and edges.

Use Pick Faces ((p][f]), Pick Edges (g

le ), or Pick Vertices (p][v]) to select a
sub-object. Then use Edit Part —

Properties to set the values. This feature
is useful, for example, to set a static load in a particular area of a
part.

e Select File = Export > Analysis Data. In the e *
dialog that is displayed, fill in the settings shown | ==~

for the specific template: i

Steps. 1000000
CoolSteps 1000000
MaxTimeFlowHeat 10

o General. This includes general settings e iCosteg 20

for the target application, and is where hasorsge 1

Iterations 1

you set the desired particle size.

Trailer File 1 FlowTrailerl-1.1inc

o Header. Contains values appearing at T T

the beginning of the generated data file.
o Trailer. Contains values appearing at the

end of the generated data.

Part-specific data is written between the Header and Trailer sections.
This data typically includes the coordinates of each particle, velocities,
material type, boundary conditions, and other application-specific values.

e Sometimes you have tables that are fairly constant such a table of
Densities and Young's Modulus values. In this case you can use the
template processor’s "file" data type to insert these tables into your
output.

e When you select , TenGun merges a point cloud for each input
object (part) with your export template and part property settings into a
single output file.

e Optionally perform manual editing on the output file. This may be
required if the template editor cannot automatically generate 100% of the
output.

¢ Run the analysis application.

Hints

e Your CAD model and particle size must use the same world coordinate
dimensions. For example, if you have a 10cm pipe and will have millimeter
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particles, the pipe length should be 0.010 (meters), not 10 (centimeters). If
necessary you can rescale CAD objects using the Geometry Editor.

e The most recent General, Header, and Trailer settings are saved in a file
named “export_template_name.export.config”, located in the
“C:\user_name\AppData\Roaming\TenGun” folder.
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Assembly Example — Part 1. Assemble the Parts

This section is a step-by-step example of assembling various CAD parts,
creating particle data to fill the inside, use of the Geometry Editor, and exporting
the data for use in an analysis application.

For this example, we will make a contraption for the person who has everything:
a “Swiss Cheese Hole Filler”. This is a totally useless device, but it is fun and
easy to implement.

Here is our strategy:

¢ We want to make a device to push particles into this block of ﬂf‘

Swiss cheese. The cheese data was a sample STEP file @7’8 )
found on the Internet. We know from inspecting the cheese 5 3

in the Geometry Editor that the size is 50.8 x 50.8 x 50.8mm.

e We need a container to hold the patrticles, so we’ll use TenGun’s box
object. We also need a square plate that fits in the box. The plate will be
used to push the particles.

¢ We need some patrticles to fill the box.

e We’'ll create the objects in this order: Box, Plate, Particles, and finally
cheese. The reason for this sequence is that when we create the interior
particles for the box, we don’t want TenGun to pre-fill the cheese, too.
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Create the Box

Here we will use TenGun’s built-in box object as a particle container. As an
alternative in a real world example, you can import your own CAD model as a

substitute container.

e Create a New Assembly scene (File = New
Assembly). For this example you can use any
Display Profile. This selection only affects the
colors that are used.

e Create a Box (Object = Insert Object =>Box).
Notice that the box size is set to the same size
as the block of cheese. (We want at least one
dimension to be the same.) Also notice that the
“Front and Back” will be open. One of the open

Create Box X

Width: ’507
Height: ’507
Depth: ’507
Wall Thickness: ’47

Open Faces
" Front " Back ©* Frontand Back { MNone

0K | Cancel ‘

sides will be connected to the cheese, and we will insert a plate in the

other side.
e The Scene Panel now shows the box like this.

Create the Plate
Create the plate with:

e Object = Insert Object = Solid Plate

e Set the dimensions of the plate to 42 x 42 x 4.
42 is 50 — the thickness of two walls.

e Select , and the Scene Panel will look like
this. (Itis difficult to see here in 2D, but the
black portion is a shadow, and the plate is
inside the box.)
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Align the Box and Plate

We now have a box and a plate, but the plate is located at the center of the box.
To align the plate to the outside of the box:

Type [p][f] (Pick Faces).
Click the plate. It will be highlighted.

Click an outer edge of the box. The front outer

wall of the box will be highlighted.

Type m to join the objects. The front face of
the plate will be aligned with the front of the
box.

The Scene Panel will now appear like this. If
you rotate the scene to look from the back,

though, you can see that the plate is indeed aligned with the front of the

box.

Create Cheese Particles

To create particles to fill the box:

File = Export Point Cloud.

Set the Point Size. Remember this value
because you will need it again later.

At this stage don’t want to convert the box
and the plate into particles. Rather, we want
to create particles to fill the inside of the box.
Therefore, check “Create interior points”.
Select [OK].

Enter a file name to write the particles to.
We've used “CheeseParticles.csv” here.
TenGun will create the particle data.

Insert Cheese Particles

Insert the particles into the box/plate assembly:

File = Open.
Choose “CheeseParticles.csv”. Be sure to
check the “Append to current scene” option.

The scene, if rotated so you can see the back,

will look like this.

B Point Cloud Settings Y
Size: 100 x 100 x 100. Bounds: X -50 to 50, ¥ -50 to 50, 7 -50 to 50.
Point Size: 1

M, ssible points: 1,000,000,

v

M 0

Maximum wal Il thickness: 0

Scan Direction

’VIVH MY Wz

Outside Spacing
Front: I 0 Back: I 0

teft [0

Top: I 0
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Add the Cheese

e File &> Open.

e Choose “Cheese.step”. Be sure to check the
“Append to current scene” option.

e The Screen Panel will appear like this. As you
can see, the Cheese object is on top of the
box, which is not what we want. We’'ll fix this
in the next step.

Move the Cheese

Use the Geometry Editor to move the cheese off of the box:

e Make the Cheese object the active object. Since we have four objects in
the scene, you can press “n” to go forward three objects (skip the box,
plate, and particles) to the cheese, or you can press “N” to go backwards
from the box to the cheese. Going either way, you should end up with
the cheese being be highlighted.

e Press or use Object = Edit Geometry to open the Geometry
Editor.

e Recall that the box size is 50x50x50. Move the Cheese object 50 units in
the —Z direction using the Translate function so it is just outside of the
box. In other scenarios you may need to rotate something, or you may
want to use Object Alignment to join faces.

At this point the scene, rotated, should look like this:
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Set the properties of each part as required by the analysis application. One by
one:

e Select a part (right-click).

« Invoke the Part Properties edit screen (type [e|[p]or us the Object >
Edit Part Properties menu item). We are not really going to run analysis
in this tutorial, so you can pick any available Export Template.

e Fill in the appropriate parameters. In this example, each part must be
given a unique value for the Material type, Bounds (boundary condition).
Additionally, the VZ (Velocity-Z) value must be set for the moving plate.

e Select[OK] and repeat for the other parts.

In this example, the full assembly contains particles that are hidden inside the
box, so you cannot right click them to select them. In this situation you can
select the part in the Tree View. You can also type |n|or to cycle through
the parts until the selected object is not visible (because it is inside the box),
and then invoke Edit Part Properties.

Hints

e Itusually takes a few tries until the data is | menu: File > Save Assembly.
perfect. As you add objects to the scene
and move them around, use File =>Save
Assembly to save your work. Then if you
need to re-do something you can reload your previous data and modify it.

¢ Notice that | have mentioned the rotated scene several times in this example.
An alternative and perhaps better way of assembling the parts would be to
attach the box to the right-hand side of the cheese instead of the front. The
box must then be initially rotated so the open front and back are oriented
correctly, but that is perhaps easier.

This saves CAD objects only. It does
not save particle data.
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Assembly Example — Part 2. Create Analysis Data

Next, we would like to run our cheese press contraption through an analysis
program. To do so:

e Select File = Export Analysis Data. | B eeertanaysisnata

e Fill in the parameters required by o= :
that application. 5 Header

e Select|OK]. e 2

e TenGun converts the Box, Plate, Steps 1000000
and Cheese Block to particle form, e
and also include the “cheese VTimefiawCoaing |50 _
particles” that we previously created. | iukenedghborstoge 1

e Enter an output file name when Temtlantlage 1
prompted. TenGun will then write all | = e
of the particle data and analysis Nsdiotl flow Tralerl-1. Lo
application parameters to that file. Output Rate 1000

e In some cases you may want to freterle RosTidud L I
perform some manual editing or
fine-tuning on the output. oK Concel

¢ Run the analysis.
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Object Editing Tools

Operations shown with the Time Series Mode O icon operate only on data that
originated as a Point Cloud. Operations shown with the Assembly Mode# icon
can be used with STEP and IGES data, and with STL data that was read with
the extended reader.

Analyze Mesh

Display information about the various polygons types in a mesh. This provides
useful information that can be used with mesh subdivision features. Output is
shown in the Message Window.

Analyze Point Density

Calculate the point density for the specified search radius. TenGun then finds
the number of neighbors for each point within that radius, storing the values in a
field named “Neighbors”.

Be careful to set the radius to no more than the particle size x 2 or 3. Otherwise
the search will include too many points and will take a long time.

This feature is useful for spotting flaws in a model such as pores and cracks
which will have low-density values.

Background Mesh

@ Some time series data (e.g., from LIGGGHTS) consists only of particles
without a container. You can enhance to display by adding background meshes
that represent the container and moving plates. Property values of the mesh
files are ignored.

There are three options on the Background Mesh submenu:

e Add. If asingle file is select it will be appended to any existing meshes in
all scenes. If multiple files are selected, each file’s mesh will be
appended to the existing mesh for that scene.

e Replace. Same as above, but previously loaded meshes are replaced.

e Remove. Removes background meshes.
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Points to Surface
O This feature applies a Delaunay 2D or 3D to a point cloud, allowing you to
create a mesh from a set of unstructured points.

Usage is as follows:

e Select the Tools = Points to Surface menu item. The following dialog
will be displayed:

B Points to Surface Settings X

Eile Name: [ Ditempitomo_nobg_Mesh.st

Maximum Search Radius: ‘ 2

Maximum Hole Size: 0

Alignment: ‘ 0
130 Mesh

[ Save s Text
[J Al Pelygons

e Fillin the parameters:

o File name. Enter the file name here, or browse by selecting the
E button. Supported output formats are OBJ, PLY, STL
(default), VTK, and VTP.

o Maximum Search Radius. If set to zero, the filters output all
triangles (2D case) or tetraheda (3D case). If non-zero, output is
limited to objects that fall within a bounding sphere defined by this
radius. In the latter case, vertices, lines, and triangles can be
generated. However, TenGun suppresses the output of vertices
and lines.

o Maximum Hole Size. Holes in the mesh up to this radius are
removed by a hole-removal filter.

o Alignment. If non-zero, particles are aligned so that the
coordinates are all multiples of this value, and redundant points
are removed.

o 3D. When checked apply a Delaunay 3D filter, othewwise a
Delaunay 2D filter. When you apply a 2D filter to 3D data, the
filter ignores the Z-coordinate and creates a mesh of the surface.
This is useful, for example, to create a lithophane.

o Save as Text. By default, output files are written in binary format.
Check this option to create ASCII text files instead.

o All Polygons. By default, the generated mesh will consist of
triangles. If this option is checked and the output file type is either
VTK or VTP, higher-order polygons such as tetrahedral will be
written. TenGun currently does not support displaying the
resulting “unstructured grid” files. However, you may use the
output with other tools to extract the polygons.
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e Select to start conversion.

e The converted mesh may be saved in another format such as a STL,
VTK, or VTP using the File = Save Point Data menu item. This data can
then be used as input to another process, and even used for 3D Printing.

Notes

e For 3D, the tool is currently limited to moderately-sized input data up to a
few hundred thousand points because the conversion process can become
slow and use a lot of memory.

e For 3D, you will generally get good results if the Maximum Search Radius
setting is approximately 2 to 3 times the point spacing. If you use a larger
value, distant corners of the object can be connected, and you can end up
with a useless giant blob.

e The Delaunay algorithm is likely to fill in small holes. To preserve the holes
you must provide particle input data with finer spacing.

e The Delaunay algorithms work best with irregularly shaped objects. For
example, conversion of simple plates or cubes is very slow.

e Very thin areas do not convert well with Delaunay 3D. Thin areas need to
be a few particles thick. Otherwise these areas are likely to become holes.
A trick that works in some cases is to rotate the object slightly so that the flat
portions are perfectly parallel to a major plane.

e During conversion from a point cloud to a mesh, scalar values such as
temperature and pressure are lost.

Remove Outliers

@ This feature removes “rogue particles”, that is particles that have leaked from
the simulation container. Such particles can interfere with the display because
particles at extreme positions require that the camera be very distant in order to
view the entire model.

When this feature is selected you will be prompted for the Minimum Neighbors
and Search Radius (a multiple of the particle size). Any particle that does not
have at least “Minimum Neighbors” particles within this radius are removed.

The Remove Ouitliers function cannot be undo (you need to reload the data to
get back the original).
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Subdivide Triangles

@ This feature first converts non-triangles to triangles. Then, all triangles are
subdivided according to the specified criteria, resulting in a triangular mesh with
more detail than the original.

Usage is as follows:

e Prepare a mesh. You can read this from a CAD file, or create a mesh via
the Tools =>Subdivide Triangles menu item. The following dialog is

displayed:
m Triangle Subdivision Settings >
Maximurn Edge Length: |

Maximurm Mumber of [terations: | 10

|
Maximurmn Triangle Area: | 1000000 |
|
|

Mazximurmn Mumber of Triangles: | 1000000

oK Cancel

e Fill in the parameters:

o Maximum Edge Length. Edges that are longer than this value will
be divided in half, and associated triangles regenerated.

o Maximum Triangle Area. Triangles with an area larger than this
value will be subdivided. This option may sometimes introduce
holes into the mesh.

o Maximum Number of Iterations. The subdivision process is
iterative. You may limit the number of passes by setting this value.

o Maximum Number of Triangles. You may limit the number of
triangles generated. However, if the limit is reached, the result

mesh may contain holes.
o Select to start conversion.
Object Alignment
& When objects are inserted or loaded from a file, you may need to align them
before generating analysis input data. There are two ways to align objects.

The first is to use the “Join Faces” function, and the second is to use the
Boolean “Union” operation.

There is a very subtle but important difference between when using “Join Faces”
versus “Union”. A union creates a single part, whereas “Join Faces” leaves the
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original parts, but they are very close together. Separate objects can be
assigned different materials and boundary conditions for an analysis application.

Join Faces Operation
& To join two objects using two faces:

e Activate Face Picking Mode (@ from the keyboard).

e Click on the face of the first object to be aligned. This will be the "from"
object.

e Click on the “to” face that you wish to align with the “from” face.

e Press ]ﬂ or|J|("Join"). The “” case joins using the minimum angle
between the faces, and “J” uses the maximum angle. The latter case
can be used when you want to flip the object over.

e You will be prompted for the “Object Spacing”, which in this case is the
spacing between the faces. If this is set to 0.0 the faces will be aligned
exactly. However, you may want to set this to the particle size that you
will use later so that generated particles are not too close.

e Select|OK]. The "from" face" will be rotated and moved so that it aligns
with the "to" face.

e Undo a Join by typing or from the Edit & Undo menu item.

Objects are aligned using normal vectors to the selected faces. There are two
normal vectors to any face pointing in opposite directions. The meaning of
“maximum angle” and minimum angle is ambiguous when rotating 90° or 180°,

so you may have to try both “” and “J” to see which works for the particle case.
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Boolean Operations
& The following Boolean operations may be performed from the Tools menu:

Difference. The first object selected becomes a “cutter”. The
intersecting areas of the cutter and each of the other selected objects is
removed, and then the cutter is deleted. This operation is useful, for
example, to create holes in other objects.

Difference (cut only). Same as above, but the cutter is not deleted.
Intersection. Create an object containing the common portion all

selected objects. The most recently selected object is replaced.

Union. Create a single object from all selected objects. The most
recently selected object is replaced. See also Join Faces.

Difference and Intersect operations may be applied to STEP and IGES data,
and Union may be used with any type of data.

Boolean Operation Example

In the following example we wanted create two plates which in the analysis
program will consist of different materials. Additionally, a hole is required
through the plates. This data can be created as follows:

Create two plates. Shift one plate with the Geometry Editor so that it
doesn’t overlap the other plate.

Create a pipe with the inner radius set to zero.

Select the pipe. The first object selected becomes the cutting tool.

With the key pressed, select both plates in either order.

Use the Boolean > Difference operator to cut the pipe out of both plates.
The pipe is deleted by the Difference operator.

Using the Difference operator on multiple objects is handy in this case—
otherwise you would need to insert and the cutter multiple times.
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Advanced Cut Operations

The Difference Boolean Operation can often be used to make simple cuts, but
more complex cuts may require several steps. One particular case is described
here.

Suppose you have a CAD object such as an engine block from which you want
to create a die casting mold. Therefore, you need the engine block, a box to
represent the mold, and a pipe going through the mold into which you will inject
liquid metal. You can easily join a pipe to the engine block and then add a box,
and you can then use the Difference operator so that the pipe will cut through
the box.

However, the Difference operation deletes the cutting tool (the pipe), and once
you have added the box it is difficult add back a replacement pipe with the same
alignment. The solution to this is:

¢ Instead of Difference, use Difference (cut only). This breaks up the CAD
object into three parts: the mold minus the exterior of the pipe, the
exterior of the pipe, and finally a disk representing the interior of the pipe
(which we do not want).

e Select the mold, and apply the Tools = Split Compound operation. This
splits the mold into two pieces: the remainder of the mold (minus the
exterior of the pipe) and the disk.

e Select the disk and delete it.
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Create Hollow Solid

&% Some CAD objects such as in STEP files are represented only by boundary
representation. If you try to export this as a Point Cloud you will end up with a
solid block of particles. This is because the visible walls in the model actually
have no thickness, so the conversion process thinks that the entire object is a
single wall. However, in most cases you want the inside to be hollow, which
you can achieve as follows:

e Select one of the major faces, such as the frontmost face (type to
enable face picking, and then click the face.)

e Select the Tools = Create Hollow Solid menu item to display the Create
Hollow Solid dialog.

¢ Fill in the “Wall Thickness” value. The units are the same as in the object
unit.

e Select|OK], and each face is “thickened” in the inward direction.

Now you can export the object as a Point Cloud with hollow insides.

Repair Shape

& The Tools = Repair Shape menu item performs basic repairs to objects
such as connecting disconnected edges and combining edges that are very
close together into a single edge.

You will be prompted for:

e Precision. The general precision limit used by the repair tool.

e Maximum Tolerance. The limit to use when determining if the objects
such as edges are “close”.

e Minimum Tolerance. The limit to use when determining when objects
such as vertices are close enough such that they can be combined.

Subdivide Faces
& The Tools = Subdivide Faces menu item splits all faces such that no face
has an area larger than the specified size.

You will be prompted for the desired maximum area.

Subdivide Surfaces
& The Tools = Subdivide Surfaces menu item splits surfaces with extreme
angles into multiple surfaces having the specified maximum angle.

You will be prompted for the maximum desired angle.
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Edit Geometry

& When you move or rotate objects with the Keys: Ctrl+G: Edit Geometry.
mouse, you are actually moving the camera. _ _
However, when you are combining objects to be Menu: EEIEE -> SRR

used for analysis, you may sometimes need to
edit the underlying geometry itself using the Geometry Editor. Operation is as
follows:

Select the object to be edited with a right-

click. You make also type [n] (next) or [N [®cer |
. Size: 100 x 100 x 100. |

(previous) to cycle through and select

objects. | comoan

Open the Geometry Editor by pressing | saing
or from the Tools = Edit |t
Geometry menu item. s
Use the dialog settings to perform the SR

desired Opera‘t|on(s) [7) Use Local Origin

Translation

X 0 Translate

o Center the object at (0, 0, 0). 0

o Scale (resize) the object. -

o Rotate the object. Rotation is x J o
counterclockwise at the angle specified in degrees. If “Use Local
Origin” is checked, rotation is around the center of the selected
object, and if unchecked rotation is around the scene.

o Translate (move) the object.

Click the corresponding button to apply the transformation.

Select to make apply the changes to the in-memory working data.
The original on-disk copy is not modified unless you resave the object to
a file.

Undo a geometry edit sequence by typing or from the Edit =
Undo menu item.

The Geometry Editor is intended for use with CAD data formats such as STEP
and IGES. You may also edit Point Cloud data with this editor, although we are
not sure if this is actually useful.

Hints

To reset viewpoint after making extreme modifications, use Zoom In, Zoom
Out, and the Camera menu and its shortcuts such as (“View from
front”).

TenGun tries to avoid excessive redrawing while you're editing the geometry.
However, if the object goes out of view you can click the Redraw button to
readjust the camera.
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e The modified geometry’s new position and orientation become the new
values used by the fjJ (“‘Home)” button.
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Image Display

TenGun can display BMP, JPEG (JPG), PNG, and some TIFF image files. This
feature is provided mainly as a convenience so that you do not need to start a
separate application to view images.

TenGun can also display DICOM (Digital Imaging and Communications in
Medicine) images. Please note the following:

e DICOM files must have an extension of “.dcm”. Sometimes these files
have no extension, and we are therefore expected to read the
DICOMDIR directory file. However, we do not currently read this file at
this time although may add this capability in the future as we collect more
data.

e The “Next” and “Previous” keyboard commands will scroll through a
series of DICOM images or through a multislice DICOM series.
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Text Editor

TenGun includes a full-featured text editor. This is based on the popular
“Scintilla” editor plugin from www.scintilla.org.

This editor is primarily a source code editor, and it therefore contains a number
of features such as syntax highlighting. At the moment, these programmer-
friendly features are not accessible from within TenGun, but we may enable
them in the future.

With the extra source code handling features and internal storage of text as
Unicode, the editor tends to be a bit memory-intensive. Therefore, you should
not try to edit huge data files with this editor if you have a limited amount of
memory. Additionally, even if you have a lot of memory, the maximum file size
is currently 2GB.

This document does not discuss editor operation in detail. Please refer to the
“TenGun Quick Reference” (available from the Help = Quick Reference menu
item) for a table of keyboard commands.
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Performance Hints

Performance on large datasets using the graphics capability built-in to the CPU
is horrible. Therefore, if you have a GPU device you definitely want to set this
as the preferred graphics device for this application.

For NVIDIA on Windows:

¢ Right-click on a blank area on the Desktop and select "NVIDIA Control
Panel".

e Under "Manage 3D Settings" select "Program Settings".

¢ Use the Add function to add an entry for TenGun.exe. (Browse to where
TenGun is installed to find the exe file.)

e Click "Apply" to activate the new preference.

e Close the NVIDA Control Panel.

Experimental Features

Certain features in TenGun are marked as “experimental”’. These are features

that may not work perfectly either because something is beyond our control, or

because the feature itself is borderline impossible. Therefore, features marked
as “experimental” are excluded from our standard warranty. Included in this list
are:

e The file browser. The basis of this feature is within a library that we use.
It is known to sometimes fail with a yet-to-be determined complex
sequence of mouse events. The same code also has difficulty dealing
properly with removable drives, and has slow response when a slow
network connection is involved in the view. The file browser is very
handy when it works, but please keep these limitations in mind.

e Point Cloud Export, Interior Points. This feature does not work for all
geometries, as discussed in this document.

e LS-DYNA support. We have only a limited number of LS-DYNA files,
and we know that some cases do not work. So that we may remove the
“‘experimental” status, any files that you can share with us would be
greatly appreciated.
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